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CHAPTER FIVE :  FORMATTING PARAGRAPHS 
 
In addition to formatting text, you can also make many modifications to paragraphs to change the way 
your document looks. 
 
 
This Chapter Will Include: 

 Aligning Text 
 Modifying Paragraphs 
 Using Tabs 
 Using Indents 
 Adding Borders and Shading 

 Adding Bullets and Numbers to Lists 
 
 
 

Aligning Text  

There are four different text alignment options in Word: Left Align , Center , Right Align , and Justify . 

 

Left -Aligned Text  ï aligns text with the left margin 

Centered Text  ï aligns from the center outward; the left and right margins are left uneven 
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Right -Aligned Text  ï aligns text with the right margin 

Justified Text  ï aligns text with both the left and right margins 
 
 

To align text, follow these steps: 

1. Place the cursor anywhere in the paragraph you wish to align. 
2. In the Paragraph group  of the Home  tab, find the alignment buttons . 
3. Choose the alignment option you want by clicking on it.  
4. By default, the entire paragraph containing the cursor will align. 

 
 

 
 

A paragraph  in Microsoft Word is defined as any portion of text separated from surrounding text by at 
least one hard return . A hard return is designed by pressing the Enter key at the end of a line. In 
addition, you cannot align half a paragraph one way and the other half another way; Word will 
automatically correct the paragraph so that it is uniform. 

 
 
 

Modifying Paragraphs  

Under the Paragraphs group  and the Paragraphs  Dialog Box , you can change the spacing between 
lines and the indentation of a paragraph.  

To modify paragraphs, follow these steps: 

1. Select the paragraph you wish to modify. 
2. To change the line spacing of a paragraph, click the Line Spacing  icon in the Paragraph 

group  on the Home  tab. This will open a menu where you can select the height of spacing. The 
default spacing in a Word 2007 document is 1.15. 
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3. To change the indentation of a paragraph, click the Increase Indent or Decrease Indent  
icons. This adds or removes a 0.5ò indent to the paragraph your cursor is in. 

4. For more options, click the Paragraph Dialog Box Launcher . There are a number of things 
you can modify here. Note that the Preview box reflects the changes you have made to the 
paragraph. 

a. General : changes the alignment of text in the paragraph 

b. Indentation : modifies the way the paragraph is indented. Left  and Right  change how 
much space is between the paragraph and the left and right margins. Special  adds 
unique types of indents to the paragraph. By changes the width of the indent. You will 
read more about indenting paragraphs later. 

c. Spacing : changes the amount of spacing in and around the paragraph. Before  and 
After add spacing in front of and following the start and end of the paragraph. Line 
Spacing  changes the spacing between lines in the paragraph. 

5. When you have made your changes, click OK. 
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Using Tabs  

Unlike previous versions of Microsoft Word, Word 2007 allows you to show or hide the horizontal and 
vertical rulers. By default, the rulers are hidden. However, you can turn them on by clicking the View 
Ruler  icon directly above the vertical scrollbar . 
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Tabs  can be used to specifically change the alignment of paragraphs or individual lines. Every tab is 
controlled by a tab stop  which begins the indentation. You can insert a tab stop by pressing the Tab  
button on the keyboard. By default, tab stops are set to 0.5 inch and left aligned. However, you can 
specify different tabs using the Tabs box  on the Vertical Ruler . 

     

By clicking on the Tab box, you can switch through the different tabs available. There are five different 
tabs and two types of indentations available through the tab box. Here are their names and functions: 

Tab Name  Symbol  Function  
Left Tab  Shifts text towards the right side of the 

page 

Center Tab  Centers text around the tab 

Right Tab  Shifts text towards the left side of the 
page 

Decimal Tab  Aligns numbers around a fixed decimal 

point 

Bar Tab  Inserts a vertical line in the document 

First Line Indent  Indents the first line only 

Hanging Indent  Indents all lines except the first one 

 

Note: The First Line Indent  and the Hanging Indent  can also be accessed through the Paragraph  
Dialog Box  mentioned above. You will read more about indents in the next section. 
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To set tabs, follow these steps: 

1. Place your cursor anywhere in the paragraph that you want to indent. 
2. Scroll through the Tab box  until you reach the tab you want to use. 

3. On the horizo ntal ruler , click the mouse in the light blue  area  directly beneath the number 
on the ruler where you want the tab to be. 

4. To change the location of the tab, simply click and drag the tab on the horizontal ruler until it is 
where you want it. 

5. Press the Tab  button and your paragraph should align itself with the tab you have set. 
6. To remove a tab, simply click and drag it off the ruler. 

 
 
 

Using Indents  

Indents  show a designated distance between the selected paragraph and the left or right margin. In 
addition to the Increase and Decrease Indent buttons already mentioned in the Paragraph group on the 
Home tab, you can change indents using the Paragraph group  on the Page Layout  tab, the 
Paragraph Dialog Box , or the horizontal ruler . 
 
 

To use the Paragraph group, follow these steps: 

1. Place your cursor anywhere in the paragraph you want to indent. 
2. In the Paragraph group  on the Page Layout tab, you can enter a specific number in the 

Indent boxes.  
3. You can also using the Spacing boxes to change the amount of space that appears before and 

after a paragraph. 
 

 
 

To use the Paragraph Dialog Box, follow these steps: 

1. Place your cursor anywhere in the paragraph you want to indent. 
2. Click the Paragraph Dialog Box Launcher  in the Paragraph group (on either the Home tab or 

the Page Layout tab) to open the Paragraph Dialog Box. Make sure the Indents and Spacing  
tab is selected. 

3. Under Indentation , you can designate an exact indent between the paragraph and the left or 
right margins. You can also change the default indent space from 0.5ò to a different number. To 
add a special type of indent, click the Special  drop-down box and choose the indent you want. 

 

To use the horizontal ruler, follow these steps: 

1. Place your cursor anywhere in the paragraph that you want to indent. 
2. Every Word document has default indents on the left and right side of the horizontal ruler. Click 

and drag these default indents until they are where you want them. 
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3. To indent an entire paragraph, click the Left indent  symbol and drag it across the horizontal 
ruler.  

4. To remove an indent, simply click and drag it off the ruler. 
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Adding Borders and Shading  

You can add borders and background colors to paragraphs to add emphasis or draw attention to a certain 
part of your document.  
 
 

 
 

To add a border to a paragraph, follow these steps: 

1. Place the cursor in the paragraph you want to apply the border to. 
2. In the Paragraph group  on the Home  tab, click the down arrow  next to the Borders  icon. 
3. In the menu that opens, you can apply a number of different border styles. To customize the 

style of the border or the color, click Borders and Shading . 
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4. In the Borders and Shading Dialog Box , make sure the Borders  tab is selected. There are a 
number of things you can change here: 

a. Setting : species which border style you want 
b. Style : specifies how you want the border to look 
c. Color : specifies the color of the border 
d. Width : specifies how wide you want the border to be 
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5. Note that the Preview  box displays what your paragraph will look like when the changes are 

applied. 
6. Click OK to save the changes. You should now have a border around your paragraph. 

 
 
To add shading to your paragraph, follow these steps: 

1. Place the cursor in the paragraph you want to apply the border to. 
2. Open the Borders and Shading Dialog Box  once more and make sure the Shading  tab is 

selected. 
3. Choose a color from the list. For additional colors, click the More Colors  button. 
4. Click OK. 

 

 
 

5. You can also add shading by clicking the down arrow  next to the Shading  icon in the 
Paragraph group. When you hover your mouse over a color, you will be able to preview how it 
will look when it is applied to the paragraph. Click the color you want to apply it. 
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Adding Bullets and Numbers to Lists  

You can create bulleted and numbered lists in Microsoft Word using the Bullets and Numbering  
feature. These lists can be customized to look any way you want them; for example, you can change the 
standard bullet icon to your own picture or change the default indentation of the lists.  
 
To create a bulleted list, follow these steps: 

1. To begin a list with bullets and designate that you are creating a list, type the asterisk (*) key 
and then press the Spacebar . 

2. The asterisk should have changed into an indented black bullet. 
3. To create a sublevel of text, press the Tab  key. Your bullet will indent even further and change 

so that it is clear this is a sublevel. 
 

 
 

4. To change the bullet icons, select the bulleted text and right-click. In the menu that appears, 
hover the cursor over Bullets  and then choose Define New Bullet . You can also select any 
bullet available from the Bullet Library  or Document Bullets  sections. 

a. You can also access this menu by clicking the down arrow  to the right of the Bullet  

icon in the Paragraph group  on the Home  tab. 
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5. In the Define New Bullet Dialog Box , you can choose to add either a symbol or a picture as a 
bullet. When you have chosen a new bullet, click OK. 
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6. To change the indentation of a bullet level, click Change List Level  in the Bullet menu. This 
opens another menu where you can choose different levels. 

 

 
 
 

To create a numbered list, follow these steps: 

1. Type the number 1 with a period following it and press the Spacebar . The number should 
indent, designating that you have created a numbered list. 

2. To create a sublevel of text, press the Tab  key. The number will indent even further and change 
to a lowercase letter so that it is clear this is a sublevel. 

3. To change the format of the numbers, select the list and right-click. In the menu that appears, 
hover the cursor over Numbering  and then choose Define New Number Format . You can 
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also choose a number style from the Numbering Library  or Document Number Forma ts  
sections. 

a. You can also access this menu by clicking the down arrow  to the right of the 
Numbering  icon in the Paragraph group  on the Home  tab. 

4. Under the Number Style  section, choose a format from the list. You can also customize the way 
the font of the numbers looks. Click OK to apply your changes. 

 

 
 
 

To create a multileveled list, follow these steps: 

1. Begin as if you were typing a numbered list. 

2. Find the Multileveled List  icon in the Paragraph group  and click the down arrow  to the 
right of it. Here you can choose a list format and make any necessary changes through the 
Define New Multilevel List  section. 

3. To create an entirely new format, click Define New List Style . 
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